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1 Introduction

1.1 General

Since the nineties, Microsoft has been working incredibly hard to meet the
requirements of global information processing and software development.

As well as supporting as many languages as possible, they have also been striving
to develop a single operating system to support all languages, unlike the language-
specific operating system versions used in the past.

As part of this project, many system components and applications have gradually
been converted to the cross-language Unicode platform.

Although these conversions will have in many cases gone unnoticed by users, the
procedure adopted to the subject addressed in these instructions will vary
fundamentally depending on the operating system being used.

The procedure recommended for Windows 2000/XP is much simpler than that for
Windows 95/NT4. We therefore recommend that you upgrade to the new system.
The instructions for the older systems have been included simply for reasons of
compatibility and will no longer be subject to editorial revisions.

Using Windows 95 or Windows NT 4
Follow the instructions in this document:

References: /IAM_TX1: Create foreign language texts with Windows 95/NT

Using Windows 2000 or Windows XP
Follow the instructions in this document:

References: /IAM_TX2: Create foreign language texts with Windows 2000/XP

1.2 Preconditions

This document describes the procedure for creating a text with the following

specifications:

e The textis to be created on a Microsoft Windows operating system
(Windows 95 or Windows NT 4).

e The textis to be created in a language not identical to the language of the
operating system (= default language).

e This description uses German as the default language for all examples provided
herein. However, the procedure described will work just as well with all localized
variants of Microsoft Windows.

e The textis to be created as what is known as a text file, i.e. without formatting
information such as font, font size, underline, etc. Therefore, in addition to text
characters, the text will only contain ASCII control characters such as tab, CR
and LF.

© Siemens AG, 2004. All rights reserved
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The language of the text requires a different Windows code page to that of the
default language, i.e. the target language does not belong to the same
language family as the default language.

The text file is to be coded using this code page, not as a Unicode file.

The target language does not belong to the pictorial languages using a double-
byte character set (Japanese, Korean, Chinese) or to the languages using what
is known as complex scripting (Arabic, Hebrew, Urdu, etc.). For the pictorial
languages, refer to the information provided in Section 4.1 "Problems and

remedies".

e The means used to create the text are to be as simple as possible, i.e. if at all
possible, no additional software should need to be installed.

Text types for HMI Embedded and HMI Advanced

The following text types can be modified in the individual systems:

Table 1-1
Text types Systems
Alarm texts HMI Embedded with PCU 20

Add texts for user interface
Application texts for all operating areas
incl. softkey texts

Alarm texts

Add texts for user interface

Texts for the Help in the editor
Machine data

Softkey texts for all operating areas

HMI Advanced with PCU 50/70

1.3 Language families

A language family is a group of languages for which Microsoft operating systems
use the same code page. Microsoft uses the term "language group”

Language family

Windows code
page

Language

Central European 1250 Albanian, Croat, Polish, Romanian, Serbian
(Latin), Slovakian, Slovenian, Czech, Hungarian

Cyrillic 1251 Bulgarian, Macedonian, Russian, Serbian (Cyrillic),
Ukrainian, White Russian

Western 1252 German, English, Finnish, French, Indonesian,
Icelandic, Italian, Netherlands, Norwegian,
Portuguese, Swedish, Spanish

Greek 1253 Greek
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1 Introduction

Language family Windows code Language
page
Turkish 1254 Turkish
Baltic 1257 Estonian, Latvian, Lithuanian
Table 1-2 Language families

Operating system and target language from one language family

If the language of the operating system (e.g. German) belongs to the same
language family as the target language (e.g. Portuguese), some difficulties may
occur when entering certain characters.

Remedy:
e Switch the keyboard or

e Use the ALT+digit combination to enter these characters, or
o Use the Windows "character map"

In this case, no further problems should occur. Section 2.4 and Chapter 3 need not
be observed.

Operating system and target language from different language families

If the language of the operating system (e.g. German) does not belong to the same
language family as the target language (e.g. Hungarian), difficulties will occur when
entering and displaying certain characters.

1.4 Windows tools

Standard scope

This document describes the use of the Windows program "WordPad" and other
aids, which are included in the standard scope of the Microsoft Windows operating
system, but are not necessarily installed on your particular PC.

The procedure described here requires that you did not exclude certain
components from your Windows installation. You should have installed the
following components:

e WordPad (required)

e Language pack (required)

e Character map (recommended)

TX1/1-6
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Checking the installation

The components listed above may already be installed on your computer. To check
your installation, proceed as follows:
e Open the "Control Panel" (in the "Start" menu under "Settings").

e Open the "Software" entry in the "Control Panel".
e Open the "Windows Setup" tab in the Software dialog box.
o Make sure that the "Language pack" option is checked.

Older versions of Windows 95 only support the Greek, Cyrillic and Central
European (or "Eastern European") language families.

Newer versions of Windows 95 (4.00.950b, known as OSR2, OEM Service
Release 2) also support Baltic and Turkish.

These components are not listed in Windows NT 4. Windows NT 4 supports
most European languages as standard.

e Make sure that the "WordPad" subcomponent is installed under "Accessories".
To do so, select "Accessories" and click on "Details".

e Make sure that the "Character Map" subcomponent is installed under
"Accessories".

Post-installing components not yet installed

If the components or subcomponents mentioned above are not yet installed,
please install them before you continue. To do so, check the appropriate boxes.
Keep the system CD-ROM to hand to install the components.

You may need the system CD-ROM again later to install the appropriate keyboard.

Windows 98

Windows 98 Version 5.00 includes WordPad. With this version, however, it is not
possible to create text files, which do not belong to the same language family as
the system language.

Recommended
Use Windows 95 or Windows NT 4.

© Siemens AG, 2004. All rights reserved
SINUMERIK 840D/840Di/810D HMI Installation and Start-Up Guide (IAM) — 03.04 Edition TX1/1-7



Creating Foreign Language Texts with Windows 95/NT (TX1) 03.04
1 Introduction

1.5 Terms

Default user

If you have activated user management in Windows 95, there is a special user
without name and password - the default user. Copy the settings of this user to
create a new user.

Logging in as the default user

1. Tolog in as the default user, press the ESC key when the log-in dialog box
appears.
- When logging in, the keyboard settings of the default user are active.

2. If you are using a keyboard layout other than that of the default user, then
(Windows 95!) the "Start = Exit = Exit all applications and log in using another
name" process will remove the current keyboard layout from the memory
without loading the keyboard layout for the default user. The log-in screen form
will then no longer function.

To avoid this, proceed as follows:
- Before you log out, either reset the keyboard settings to the original
keyboard layout
- Or restart Windows.

If the log-in screen form is already blocked, proceed as follows:
- Press Ctrl-Alt-Del and choose "Shut down".
- Or press ESC (to log in as the default user) and select "Start > Exit >
Restart Windows".

Diacritical characters

(diacritical = distinguishing)
In most cases, a relatively small supplementary character is attached to a letter to
give the letter a specific stress, a specific pronunciation or even a new meaning.

A list of diacritical characters appears in Section 3.1 "Special characters...".

If the combination of basic letters and diacritical characters belongs in a language-
specific alphabet, this combination is contained in the appropriate Windows
character sets (code page, Unicode) as a separate character.

© Siemens AG, 2004. All rights reserved
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Use of diacritical characters

A diacritical character is used:
. To designate the combined character (e.g. G = G cedilla, O = O-tilde)

o For combined input (see Section 3.4) if there is no dedicated key for the
required combined character

. For output (only in typographically compound texts): Diacritical characters
and basic letters are output separately; any combinations are possible, e.g.
with ancient languages and phonetics.

In all other cases, the combined letter is always considered as a compound unit.
In some cases, however, the combined letter is incorrectly also treated as the
diacritical character.

Input Method Editor (IME)

An aid for entering CJK characters (CJK: Abbreviation for Chinese, Japanese and
Korean).

Language property

A property (attribute), which is managed in Microsoft text processing programs as
other text properties per character. In such cases, the program will remember the
language to which the character, the character sequence, the word or the whole
sentence belongs.

Word and WordPad support this property, NotePad does not. In both programs,
this property is not directly visible.

Saving the language property

Word documents also save this property, but text files do not.

This property is used (evaluated) for the spell checker (Word) and for the automatic
keyboard switchover (see Section 3.7).

It is specified by the default keyboard setting (with text from text files, new files)
and by the current keyboard setting (newly entered text).

Changing the language property

In Word, the language property can be changed using the "Tools - Language"
menu command. In WordPad, this property cannot be changed.

In WordPad, the language property is independent of the font language family. For
example, a Cyrillic character can possess the language property "German".
Modifications are only possible in the following cases:

. When the keyboard is automatically switched to another language,
WordPad will also switch the font language family to the appropriate
language family.

© Siemens AG, 2004. All rights reserved
SINUMERIK 840D/840Di/810D HMI Installation and Start-Up Guide (IAM) — 03.04 Edition TX1/1-9



Creating Foreign Language Texts with Windows 95/NT (TX1) 03.04
1 Introduction

o When changing the "Font language family" text property, WordPad will
automatically change to the appropriate keyboard setting if a keyboard
setting with the appropriate language property exists. However, this change
is undone with the next time a key is pressed.

Managing the language property

The language property is managed internally as a combination of main language
and sublanguage, e.g. "French (Canada)".

Microsoft sometimes uses the designation "locale" for the language property,
whereby this term also covers properties such as currency, date format, decimal
separators, etc.

Language family

A language family is a group of languages, which uses the same code page. This
requires the use of the same basic alphabet (e.g. Latin or Cyrillic), but it does not
mean that the alphabet of all languages of this group is the same.

Instead of font files stored separately for each code page, Windows NT4 and
Windows 95 (with "language pack" installed) use what are known as "Big Fonts",
i.e. fonts that contain the character set for several code pages, saving memory
capacity for common characters.

The appropriate subset for this total character set is not selected via code page
numbers but via the language family. However, there is a 1:1 assignment between
Windows code page and language family.

Section 1.2 contains a list of the language families in Table 1-1.

Default language

The term "default language" is used in this guide for the language of the operating
system, i.e. German in a German version of Windows and English in an English
version of Windows.

Default keyboard setting

One setting is defined as the default keyboard setting under "Control Panel" >
Keyboard in the "Language" (Windows 95) or "Input" (Windows NT 4) tab. This
setting is selected when the dialog is opened.

The default keyboard setting consists of a language property and a keyboard
layout.

This language property of the default keyboard setting need not tally exactly with
the default language.

© Siemens AG, 2004. All rights reserved
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Unicode

A 16-bit character set with which no more code pages are required. Unicode
programs cannot interpret characters on a code-page-specific basis, which means
that their appearance does not change according to the font language family
selected.

Undeletable line feed

At the end of the text file, WordPad displays a last line feed, which can be selected
(highlighted), but not deleted.

The font properties of this line feed can be changed, but not the language property.
When positioning the cursor at the end of the file, the font properties and the
language property of this line feed will be used for the text added at the end of the
file.

A new, empty file also contains such an undeletable line feed. To see the
undeletable line feed, select the whole empty file, as described in Section 2.2.

It will not be saved with the file.

© Siemens AG, 2004. All rights reserved
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2 Editing Files

2.1 Starting WordPad

Start the "WordPad" program (under Start > Programs - Accessories).
The procedure for editing files will vary depending on whether you want to create a
new file or edit an existing file.

2.2 Creating a new file

When "WordPad" starts up, an empty document will appear. "WordPad" can
manage multi-language texts. The new file will be treated as belonging to the
language set as the default setting on the keyboard. However, this may be ignored
initially if the keyboard does not need to be switched (see Chapter 3 "Changing the
keyboard layout").

1. Use the mouse to select the whole empty document by clicking on it, e.g. to the
left of the cursor.

File Edit “iew Inzert Format Help

DS | 2E & 2=

ITimes Mew Roman Mwestern]

e

Figure 2-1

- Click >

Eile Edit “iew Inzert Fomat He

D= SR 6] &

ITimes Mew Baman M estern)

ORI

Figure 2-2

2. Set the font and language family, as described in Section 2.4.
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2.3 Opening an existing file

1.

2.

In Word Pad, select "Open" from the "File" menu.

From the "Open" dialog box, choose the "Text Documents (*.txt)" setting under
"Files of type". Search for the file you want to open and then click on "Open". If
your file has a different extension, then select "All Documents (*.*)" from the
"Files of type" menu.

The file opens. WordPad can manage multi-language texts. Since the text file
does not contain language information, the text is treated as belonging to the
language set as the default setting on the keyboard. However, this may be
ignored initially if the keyboard does not need to be switched (see Chapter 3
"Changing the keyboard layout").

No text attributes are stored in the text file, meaning that the text will under
certain circumstances be displayed using the wrong code page and
language-specific special characters will not appear correctly. Therefore, first
you must set the font and the language family.

To do so, choose the entry "Select All" from the "Edit" menu or press Ctrl-A to
select the whole file.

Set the font and language family (see Section 2.4).

2.4 Setting the font and language family

Select an appropriate font, together with the desired language family.
For improved differentiation between language-specific special characters
suchas U, G, G, G, and G oreveni, i, 1and i, it is advisable to select a font with
a fixed character width (i.e. not a proportional font) and to choose a
reasonable font size such as Courier New 12 or larger:

4, 4, o, 4, G, 1, 1, 1, 1i.
You should also select the language family according to the

list in Section 2.4.

| Important

These settings have to be made again every time the file is opened.

You can choose the font in two different ways: Figure 2-3
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Font list box

1. In the font list box, the language family is specified in brackets after the font
name in the editing line. All fonts that support several fonts appear several
times.

If the format bar is not visible, use "View" to activate it.

Document - WordPad

File Edit “iew |lnzert Fomat Help
D@ sl @] 2] &
Couner Mew [Turkish] J I_

;I_

“|Hp Comic Sans M3 [Tuwrkish)

T Comic Sans M5 [Western)

T Courier Mew [Baltic]

T Courier Mew [Central European)
T Courier Wew [Cyrillic)

T Courier New [Greek)

I

Courier Mew [Turkish]
T Courier New [Western]
T Courier Mew CE
T Courier Mew Cyr
T Impact [Baltic) -

Figure 2-3
Font dialog box

2. Use the font dialog box to select the font type and language family separately.

Choose the "Font" command from the "Format" menu to open the font dialog
box.

From the "Font" menu, choose the name of the font, and from "Script", the
language family of the font.

Font
Faont: Font style;
Coaurier Mew |Hegular
T Avial Cyr a
H Comic Sans M5 _I Italic
o | |Baid
- Courier New Bald talic
B Courer Hew Cyr
Fizedays LI
— Effect — Sample
[ Stikeout .
[ Underline AaBbGg 55
LCaolor:
I- Black 'I St
| Turkish =

Thiz iz a TrueT ype font. This same font will be uzed on both
your printer and pour screen.

Figure 2-4
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These settings will change the appearance, but not the coding, of the existing text.

Example: Character 140 Western: € Cyrillic: b

Windows 98

Under Windows 98, the existing text remains unchanged, i.e. the formatting with
the desired font language family remains without effect. In WordPad Version 5.0,
the characters are saved internally in Unicode so that changing the language
family would be the same as changing the code page.

Example: Unicode U+0152: & Unicode U+040A: i

Note
It is not possible to use Windows 98 for this purpose.

2.5 Checking settings

1. First check whether the desired font type and the language family are
displayed in the format bar.

If a language family other than that selected is displayed, you may have an

unsuitable installation:

e The language pack may not be installed. Check whether the Windows
"language pack" component is installed, as described in Section 1.3.

e Your Windows system may include a variant of WordPad, which does not
permit the language family settings you have chosen for the existing text
(WordPad Version 5.00 and higher, e.g. Windows 98). In this case, you
should use an older Windows version, e.g. Windows 95 or Windows NT 4.

Special characters belonging to various language families
2. If you have opened an existing file, check visually whether the special
characters contained therein are displayed correctly. The sequence is always
23-24-25.

Since some special characters appear in several language families, you
should focus on those characters that do not appear in other languages or

language families:
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2 Editing Files

Table 2-1 Special ¢

haracters

Language family

Characters that only occur here

Characters that also occur in
other language families

Baltic languages

AAeEECaA&dAc06088 1Uz7

Central European

aAéCeE115527 (Polish)

60

EC&EFRAU (Czech) aAeEilyyzz
5640 (Hungarian) aAéEilo060uuUutU
Turkish GG1iss cCo0uu
3. Type a special character to test whether your settings are correct. If you have
opened an existing file, no text must be selected (for example press Ctrl-End to
go to the end of the file).
Use the input method ALT+numerical keypad to type a special character,
which is displayed differently in each language.
Example:
Table 2-2  Example: Special characters
Entry Language family Display
ALT+0254 Baltic 7
ALT+0254 Greek Q
ALT+0254 Cyrillic 0
ALT+0254 Central European T
ALT+0254 Turkish S
ALT+0254 Western b
© Siemens AG, 2004. All rights reserved
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2.6 Saving files

Save the text entered as a text file:

1.  Choose the "Save As ..." command from the "File" menu in WordPad.

oo HE|
Savein: | ‘i SINUMERIK 840D =] gl

File name: ID::u:ument. A Save

Save as type: ITe:-:tDu:u:ument j Cancel |

Figure 2-5

2. Choose the "Text Document" setting under "Save as type".

3. Type the complete name with extension (e.g. ". txt") in the "File name" field.
WordPad will not generate this extension automatically. If you keep the
".doc" extension, the text file will be saved with this name and interpreted as
a Word document.

4. The following message will appear the first time you click on "Save":

wordPad EHE

@ Y'ou are about to zave the document it Text-Only farmat, which will remove all farmnatting. S ave Document as

whord 6.0 D'ocument i Rich Text Document Text Document Cancel

Figure 2-6
5.  Click on "Text Document".
Your file will now be saved as a text file. When the document is next opened,

font type, language family and language property will be reinitialized, as these
properties are not saved.
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SINUMERIK 840D/840Di/810D HMI Installation and Start-Up Guide (IAM) — 03.04 Edition TX1/2-19



Creating Foreign Language Texts with Windows 95/NT (TX1) 03.04
2 Editing Files

Retaining the language property
If you are using the variable keyboard layout with the correct language assignment
(see Section 3.7), you may first want to maintain the language properties of the text
entered in order to continue editing the file later. To do so, select the file type
"Word for Windows 6.0" when saving and use the ". doc" extension.

After you have finished your work, save the file as a text document to obtain the
final file format.
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3 Input of Text

3.1 Special characters belonging to various language families

Latin language family

With the Latin-based language families (Baltic, Central European, Turkish,
Western), you can enter most of the characters, namely the basic Latin alphabet,
directly with your (e.g. Western) keyboard.

Most of the special characters, suchas Ad4dcdéeIitNAss0tTaq,
consist of the Latin letters A-Z a-z combined with diacritical characters, such as

acute ”, breve 7, cedilla s, circumflex (caret) ~, colon (dieresis) *, point ", double-

acute ”, grave accent ", hacek”, macron ~, ogonek (nasal hook, crooked hook) «,

squiggle °, slash /, hyphen — or tilde ™.

Other characters of the alphabet are special letters (PP, D&, B) orligatures
(Fe, e, 1Ji). Language-specific abbreviations and punctuation marks are

also used, e.g. for the endings of the ordinal numbers in Spanish (? and °) as well
as upturned exclamation and interrogation marks (j and ¢,).

The input methods described below apply only for Latin-based language families
without limitations.

Greek/Cyrillic language family

The input of texts using Greek or Cyrillic fonts is subject to some special features,
which must be observed.
Refer to Section 3.8.

3.2 Numerical input

Press and hold down the ALT key and enter zero followed by the three-digit
decimal coding for the desired special character on the numerical keypad. Then
release the ALT key.

Example (Turkish):

ALT+0222 results in $ (S with cedilla).

To produce this character, you will only need the character map of the appropriate
code page (see Section 1.2).

You will find overview tables for the code pages e.g. at Microsoft at:

http://msdn.microsoft.com/library/default.asp?URL=/library/books/dev
intl/s2570.htm
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3.3 Input via the character map (Windows 95 only)

31In

put of Text

Windows NT 4 offers the Unicode character map. Here you can use this method
only if you also switch the keyboard layout to the target language (see Section 3.7).
This method is therefore described here only for Windows 95.

Selecting the character map

In the Start menu, select Programs - Accessories = Character Map to open the

character map.

Under "Font", choose the same font as you have selected for the text file.
Depending on the version of your Windows 95 operating system, you will see the

language families listed as font type variants:

&5 Unicode Character Map

Eont:l_'ﬂTCourierNewCyr =1 Chﬁ'aCtB'SlUCUDPZI

T Arial Cyr =~

T Comic Sans M3 = |-|. [/ |o|t]e|s|als|e|?|s|2|:|:|<|=]|=]?

’H‘Egaﬂz:mw ululofelelr|s|tlulvlul=zlr|z[c N1 [+

T Courier Mew CE mnlo|plal|c|s|t|u|viw|x|v|z|{]|I|}]|~]|0
“tEls|uls[ ] |- —|-lo™|es|e|a|a|a

Fli|af=]|r | El@|e|«|n|-|@| L[ [x|[T|i|r{n|n]|-|&W|e|=|3]|5|a|1

AlB(e(r(m(E|®|s (m|i|x|x|u|a|o|{o|e|c]|T|v|e|x|n|u|m|m|sx|s|a|w|a

algle|n|o|e|m|(z|u|d|n|n|u|ux|o(o|p|e|{T|v|d (o || (6| |2 o a

I [ 3

Cloze

Select

LCopy

u

|Fonts available for character selaction.

Keystroke: Space

Figure 3-1

Language codes

The following codes are used for the language families:

Baltic Baltic
Greek Greek
Cyrillic Cyr
Central European CE
Turkish Tur
Western None

Precondition

In more recent versions of Windows 95 (4.00.950b, known as OSR2, OEM Service
Release 2), all language families mentioned in Section 1.2 will appear here.
If you are using the original version of Windows 95 (with or without Service
Pack 1), you may not be offered these language versions. In this case, you cannot

use this method.
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Entering characters

1. Choose the characters you wish to enter.

2. After each character, click on "Select".

3. Once you have selected all characters, click on "Copy".
The characters will be copied to the clipboard.

4. Go back to WordPad and press Ctrl-V.
The characters are pasted from the Clipboard into the text

Note

The characters are always inserted with font size 12.

The font you selected in the "Character Map" program is assigned to the
characters as a font setting when they are inserted into WordPad. If this font is
not the same as the one you selected previously in WordPad, this will produce a
font mix or even a font family mix in WordPad.

3.4 Compound input

Example

With many compound special characters, it is possible to enter first the diacritical
character and then the letter. The diacritical character will not appear at first and
will then be combined with the letter to form a special character.

For example, press the * (acute) and "a" keys one after the other to obtain a copy
of the character a (a-acute).

The keys with the diacritical characters, which are thus dealt with in a special way,
are marked in the descriptions of the keyboard layouts with a special color.

Keyboard layout

TX1/3-24

The table below shows some keyboard layouts for the diacritical characters
supported:

Table 3-1
5 e
x =)
¢ € 5 < |58
@ |2 |5 Slol8lal|lcs|2 2|
= 5] s) > o c o he] > > a
3|8 |ls|s |2 ||| |® |3 |T|=
Keyboard < |0 lolz|lmloflalolololn lE
assignments R ~ v | - v o |~
(9 >
German X X [X
French X X X X
Polish X X X X X X X X X X
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c 2
[0} x =
g |s . e
o |lo |Elx¥|ol8|o|c|2|2|8
> ® o |9 q>g c |l |L |D S = g
o Ol £ |®© o o | S o o} [} T | =
< | O O | T om O |o O 10 10 n =
Spanish X [X [X X X
Czech X X X X X X X X X X
Hungarian X X |X [X [X X [X [X [X
US International X [X [X X X

Obtain a graphical representation of your keyboard layout to learn which key
combinations produce the diacritical characters.

Keyboard layout in pictorial format
Images of the keyboard layouts can be obtained from Microsoft via the Internet at

the following address:
http://www.microsoft.com/globaldev/keyboards/keyboards.asp

If you press the space bar after the diacritical character, you will see the character
itself.

Note

It may be advisable to switch the keyboard layout to "US International”, which is
essentially the same as the American keyboard but also contains 5 diacritical

characters and provides many special characters.

3.5 Permanent changes to the keyboard layout (without quick

switchover)
You can use the procedure described in this Section to change the keyboard layout
for your whole user interface, i.e. also for Windows itself. This is the simplest

method of changing the keyboard layout.
Under Windows 95, you can only use this variant. Under Windows NT 4, you can

also set up the keyboard so that it can be switched over (see Section 3.6).

Changing the keyboard layout
To change the keyboard layout (description of the dialogs here as in Windows 95),
proceed as follows:

Keep the installation CD for your operating system to hand.

In the Start menu, select Settings = Control Panel.

On the "Control Panel", click on "Keyboard".

Select the "Language" tab (in NT 4: "Input Locales"). Here you will see the
existing "Keyboard Language" (left-hand column; NT 4: "Input locales") and
"Key Settings" (right-hand column) assignments.

One entry is defined by default:

rpON=
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TX1/3-26

Your default language (the language of your operating system) with your

default keyboard layout. This entry is selected and specified below as the
default entry.

At least one entry exists (the default entry).

Keyboard Properties

Speed  Input Locales | Genelall

— Inztalled input locales and layouts

Input lacales: Layout:

Add. Fropertiez | Hemave I
Default input locale: English [United States] Setas [efaut |
— Switch locale:

) [Left Al Shift €S0 ElsEhit € Hare

I Enable indizaton on baskiar

QK I Cancel Aol

Figure 3-2

5. Make sure that the default entry is selected and click on "Properties". The
"Language Properties" dialog box (NT 4: "Input Locale Properties") will
appear.

6. Select a suitable keyboard layout for the target language and click on OK.

Input Locale Properties [ 2] |

Locale: Palizh

K.eyboard lapout;

Fiussian [Typewriter] ﬂ
R omanian “
Fuszian

[Serbian [E_I,Irillc]
Serbian [Latin

Figure 3-3
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7. Click on "OK" to quit the dialog. Some keyboard drivers may now be loaded
from the CD, meaning that you will have to restart Windows.

Keyboard Properties EHE

Speed  Language I General |

— Inztalled input locales and lapout:

Language: Layaut:

Add... Properties | Bemuve |

Default input locale: English [United States] et as [efault |

r— Switch locales

) LefbalteShift €00 BhlsShitt: ) Hore

™| Enatle indicatan arbaskbar

ak I Cancel Apply

Figure 3-4

Note

Important for Windows 95:

Do not try to set up the target language as such using "Add".
Some additional conditions still need to be met

(see Section 3.6).

Result

You will create text with a keyboard layout suitable for the target language. The text
display has already been adapted by setting the font with the language family as
described in detail above.

Your default language, e.g. German, will be used unchanged as a text language
property managed internally by WordPad (i.e. WordPad will assume that your texts
will be created in German). If you were to transfer text to Word using the copy and
paste function, the German spell checker would be used.

If you were to set the target language as the keyboard language, although the
language property would be correct, you would still have to take some additional
issues into account (see Section 3.7).
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Note

e All menus will also use the switched keyboard layout. You will no longer find
your key combinations with Alt and the appropriate letter key (e.g. Alt-D for
the "File" menu) or Ctrl + letter key (e.g. Ctrl-V for "Paste") and could even
inadvertently initiate a wrong command. You should therefore use the mouse
or, in menus, the arrow keys.

e Obtain